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SUMMARY:  The rapid advancement of the Internet of Things (IoT) has transformed our lives by connecting objects and creating an

intelligent environment that drives automation and massive data collection. IoT has overcome challenges through remote monitoring, robotics,
and sensors, with powerful wireless technologies opening up possibilities in various fields, including anatomical techniques. The objective of
this study is to demonstrate the feasibility and benefits of integrating IoT technology into the body maceration process by developing a low-cost,
accessible, automated maceration control device compatible with the Arduino IDE programming environment. Using an open-source NodeMCU
system based on the ESP-12E chip, which employs the LUA programming language and is compatible with Arduino IDE, we incorporated a
microSD card reader module for data storage, a digital temperature sensor (DS18B20), a clock module (DS3231), a magnetic stirrer, and an
aquarium heater controlled by a digital thermostat with relay (W1209). To validate the device, we conducted maceration tests on C57BL mice,
comparing two groups: Control (n=5; weight=17g) subjected to maceration in 4 liters of water at 10°C without agitation; Experimental (n=5;
weight=17g) exposed to maceration in 4 liters of water at 35°C, with agitation at 1500 r/min and water flow renewal at a rate of 900 ml/h.
Specimens were evaluated for their degree of maceration, cleaned, weighed, and photographed. The maceration time for the control and experi-
mental groups was 730 hours and 60 hours, respectively. In the experimental group, no foul odors, damage, or bone demineralization were
detected. The device cost was 60 USD, and programming through the Arduino IDE environment was straightforward. The focus on hardware
contributed to accessibility and time savings. The system operated with a conventional power supply and required a water supply, making it
adaptable to various configurations with greater capacity. Under this configuration, we effectively controlled the variables (temperature, agitation,
and water flow). The NodeMCU-based bone maceration system improved the performance and adaptability of existing systems and increased
accessibility by reducing costs, complexity, and foul odors.
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INTRODUCTION

The rapid advancement of digital health technologies
has significantly transformed various fields within medical
sciences, notably through the integration of Internet of Things
(IoT) applications. These advancements have been
predominantly observed in clinical settings such as
orthopedics, robotic surgery, and cancer care, where IoT
facilitates real-time data collection, monitoring, and analysis
to improve patient outcomes (Sadoughi et al., 2020).
However, the field of anatomy, a cornerstone of medical
education, has been slow to adopt these technological
innovations, largely relying on traditional cadaver-based
teaching methods (Aghdam et al., 2021; Wickramasinghe
et al., 2022). IoT technology has been indispensable for
monitoring and automating industrial processes, commonly
used by tech companies but rarely in biological experiments
(Parks et al., 2022). An IoT-based monitoring system can

collect, transmit, analyze, and supervise data in real-time
(Zhang et al., 2024). In the discipline of anatomy, the use of
this technology has been limited. Maceration for
osteotechnique presents an ideal candidate for IoT integration
as it is a technique that has not reached higher complexity
levels in terms of equipment used and data collection.

Maceration, a relevant process in osteology and
anatomical preparation, traditionally involves manual
cleaning and degreasing of bones, often leading to
inconsistencies and prolonged processing times. Integrating
IoT technology presents an innovative approach to optimize
this process by enabling precise control and monitoring of
variables such as temperature, agitation, and water flow
(Parks et al., 2022; Zhang et al., 2024). Bridging the gap
between traditional anatomical practices and modern digital
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techniques by developing an IoT-based system to streamline
and improve the bone maceration process is an unaddressed
challenge. In this study, we have optimized the practice of
bone maceration by designing and building a system that
incorporates data acquisition and storage, as well as control
of agitation, temperature, and water flow. Using cost-
effective technological resources such as Arduino-type mo-
dules and sensors, and NodeMCU development boards
programmable via Arduino IDE software (Matuska et al.,
2022), we have created a system that significantly accelerates
the maceration process. This system not only allows remote
monitoring but also facilitates the adjustment of key varia-
bles during decomposition by regulating the activity of
components responsible for heating and agitating the water.

The importance of this study lies in the innovation it
represents for osteotechnique and anatomy in general,
providing a modern tool that enhances the efficiency and
precision of the bone maceration process on a scalable level.
A review of the literature reveals a gap in the application of
advanced technologies such as IoT in anatomy, particularly
in anatomical techniques, highlighting the need for studies
that explore and validate their use. Therefore, the objective
of this study is to demonstrate the feasibility and benefits of
integrating IoT technology into the bone maceration process
by developing a low-cost, accessible, automated maceration

control device compatible with the Arduino IDE programming
environment, setting a precedent for future research and
applications in anatomy and other biological disciplines.

MATERIAL AND METHOD

Maceration bucket and device case. All electronic
components (Table I) were mounted and organized within a
“control box” (IP55; SAIME SG) measuring 187 mm x 187
mm x 105 mm. Initially, holes were drilled into the box to
accommodate the various components necessary for the
system. The macerator consisted of a 10-liter bucket with a
hermetic seal lid (1H2/Z1.2/120/*/RCH/P.HADDAD),
which included an inlet and outlet for water, a transparent
plastic window, and a PG-7 cable gland (3.5 mm-6 mm) for
the heater cable. Additionally, connections for the water inlet
and outlet were incorporated (Fig. 1). A bottle with a chlorine
tablet was connected to the water outlet hose to eliminate
odors from the waste water.

Electronic components. A generic ESP8266 NodeMCU V3
module, based on the ESP-12E chip, was used with an open-
source NodeMCU system, employing the LUA programming
language and compatible with Arduino IDE, allowing data
transmission via WiFi. This system was complemented with
a microSD card reader module for data storage. The control
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Fig. 1. The maceration control system consists of several key components: (a) a 10-liter distilled water container, (b) a 10-liter maceration
container, and (c) a control box. The diagram of the control box includes (letters in red): A) DS18B20 thermocouple, B) SD card reader
module, C) 12V motor with neodymium magnet, D) W1209 relay thermostat, E) submersible aquarium heater, F) ESP8266 NodeMCU
V3 CH340 development board, G) IRFZ44N MOSFET, H) 10k variable resistor, I) RTC3231 module, and J) B3950 NTC thermistor.
The temperature of the bone maceration system can be monitored through a mobile phone interface, and the data is stored on an SD card
in .txt format, expressed as date, time, and temperature.
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device included a DS18B20 digital temperature sensor, a
DS3231 clock module, a magnetic stirrer, and an aquarium
heater controlled by a W1209 digital thermostat with a relay.
A phone charger (5V) was used to power the development
board and its modules, and a 12V charger was used for the
relay thermostat, as well as for the fan and magnetic stirrer
motors.

Circuit.  The temperature control of the maceration system
was achieved using a HC-50 50W Steel aquarium heater
(Sobo), controlled by a digital thermostat with a relay (mod.
W1209; 12V) featuring an NTC temperature sensor. The
thermostat was set to maintain a constant temperature of 35°C
in the experimental group. The DS18B20 temperature sensor
was placed inside the maceration bucket to monitor the water
temperature in real-time. This sensor sent temperature data to
the NodeMCU (ESP8266), which adjusted the heater through
the digital thermostat to maintain the desired temperature. The
W1209 thermostat activated or deactivated the relay as needed
to regulate the power supplied to the aquarium heater. The
NodeMCU served as the system's brain, providing WiFi
connectivity and processing power to control all components.
This microcontroller was programmed using the Arduino IDE
environment. Several modules were connected to the
NodeMCU to achieve the desired functionalities, such as a
microSD card reader module (for storing data collected during
the maceration process), a DS18B20 temperature sensor
(connected to the NodeMCU to measure water temperature
inside the maceration bucket, utilizing the "OneWire" library
for communication), and a DS3231 clock module (providing
accurate time and date for recording events during the
maceration process, connected to the NodeMCU via I2C
communication). The NodeMCU recorded the temperature
sensor data and the DS3231 clock module data using the
programming defined in Arduino IDE. A magnetic stirrer was
used to ensure constant agitation of the water inside the

maceration bucket in the experimental group. This component
was controlled by a simple voltage regulator circuit with a
potentiometer, adjusted to 1500 r/min. This constant agitation
ensured uniform temperature distribution and greater
efficiency in the maceration process. These connections and
configurations ensured that the bone maceration system
operated efficiently, precisely controlling critical variables such
as temperature and agitation, and allowing for remote
monitoring and adjustment through the IoT connectivity
provided by the NodeMCU.

Code. To create and implement the code, Arduino IDE 1.8.19
was installed (https://www.arduino.cc). Initially, the esp8266
library was installed from the page: https://github.com/
esp8266/arduino. The link https://arduino.esp8266.com/
stable/package_esp8266com_index.json was copied and
pasted into the Arduino IDE menu: "File > Preferences >
Additional Boards Manager URLs". Then, "esp8266" was
searched in the "Tools > Board > Boards Manager..." section
and the esp8266 library (version 3.1.2) were installed. To
connect the RTC clock module and the DS18B20
temperature sensor, the corresponding libraries were installed
in the "Sketch > Include Library > Manage Libraries..."
menu. "rtclib" was typed in the search field and "RTClib by
Adafruit" was installed. Similarly, the "OneWire" library
(version 2.3.7) was installed.

Specimens and groups. To validate the device, we conducted
maceration tests on C57BL mice. Two groups were contrasted:
control (n=5, weight=17 g) subjected to maceration in 4 liters
of water at 10 °C without agitation, and experimental (n=5,
weight=17 g) exposed to maceration in 4 liters of water at 35
°C, with agitation at 1500 r/min and water flow renewal at a
rate of 900 ml/h. The specimens were evaluated based on
their degree of maceration, and additionally, they were
cleaned, weighed, and photographed.

Component Description

12V 2A Charger Power supply providing 12V and 2A for electrical devices.
10k Potentiometer Adjustable resistor of 10 kilo-ohms used to control voltage or current.

MOSFET IRFZ44N Field-effect transistor used for switching and controlling high currents.
5V 2A Cell Phone Charger Power supply providing 5V and 2A for charging mobile devices.
Generic ESP8266 NodeMCU V3 Development board based on the ESP-12E chip, compatible with Arduino IDE, for WiFi connectivity.

PG-7 Cable Gland (3.5 mm - 6 mm) Accessory used to secure and seal cables at entry points of electronic equipment.
12V Computer Fans FAN-8025 (2 units) 12V fans used for cooling and air circulation and the magnetic stirrer.
HC-50 50W Aquarium Heater 50W stainless steel heater for maintaining water temperature in aquariums, brand “Sobo.”

IP55 Junction Box Waterproof junction box measuring 187 mm x 187 mm x 105 mm for housing electrical components, brand
SAIME SG.

10-Liter Bucket with Hermetic Lid 10-liter container with a h ermetic seal lid for maceration, brand HADDAD.

Micro SD Card Module Module with SPI interface for data storage on Micro SD cards, compatible with Arduino.
DS18B20 1-Wire Temperature Sensor Waterproof digital temperature sensor made of stainless steel with a 1 -meter cable.
W1209 Digital Thermostat with Relay 12V temperature controller with a relay and waterproof NTC stainless steel sensor.

I2C RTC DS3231 Module Real-time clock module with Atmel24C32 EEPROM memory and CR2023 3V lithium battery.

Table I. Components used in the low-cost bone maceration control system
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RESULTS

The total maceration time for the control and experi-
mental group specimens was 730 hours and 60 hours,
respectively. In the experimental group, no foul odors,
damage, or bone demineralization were detected. The cost
of the device was $60. Programming through the Arduino
IDE environment was straightforward. The hardware-
focused approach in creating the device contributed to
accessibility and time savings. The system operated using a
conventional power outlet and required a water supply,
making it adaptable to various configurations with greater
capacity. Under this configuration, we effectively controlled
variables such as temperature, agitation, and water flow. We
evaluated the effects of two different maceration protocols
on rat specimens, organized into two groups: control and
experimental. Observations were made at specific time
intervals: 0, 15, 24, 39, 48, and 63 hours (Fig. 2). The
specimens in the control group were subjected to a constant
maceration protocol at 10 °C without agitation. At 15 hours,
barely any changes were noticed in the specimens. At 24
hours, there was a slight reduction in tissue, but the specimens

remained predominantly intact. At 39 hours, changes were
minimal compared to the experimental group, with most soft
tissue still present. At 48 hours, slight maceration was noted,
but the skeleton was not clearly exposed or disarticulated.
At 63 hours, although some decomposition had occurred,
the soft tissue largely adhered to the bones, and
disarticulation was not complete. The specimens in the ex-
perimental group were subjected to a constant maceration
protocol at 35°C with constant agitation at 1500 r/min and
water renewal at a rate of 900 ml/h. At 15 hours, a clear
reduction in soft tissue was observed. At 24 hours, most soft
tissue had been removed, exposing a large portion of the
skeleton. At 39 hours, the specimens showed almost com-
plete maceration with bones clearly visible and well-defined.
At 48 hours, the skeleton was completely disarticulated and
clean. By 63 hours, all bones were completely separated and
clean, with no visible soft tissue remnants. These findings
demonstrate that the maceration protocol used in the experi-
mental group, which included higher temperature and constant
agitation, was significantly more efficient for the rapid and
complete maceration of bone specimens compared to the con-
trol method at a lower temperature and without agitation.

Fig. 2. Comparison of the cadaveric maceration process between the experimental group and the control group at different time intervals.
The graph shows the progression of the bone maceration process in the experimental group compared to the control group at various time
intervals: 0 h, 15 h, 24 h, 39 h, 48 h, and 63 h. The experimental group utilized a maceration control system based on NodeMCU and
Arduino-IDE, featuring precise control of temperature, agitation, and water flow. The control group did not employ these additional
controls. The figure illustrates the efficiency of the experimental system in accelerating the maceration process and improving the quality
and consistency of the obtained bone specimens.
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DISCUSSION

In the present study, a low-cost and accessible bone
maceration control system was developed and validated,
based on the integration of IoT technology with NodeMCU
and Arduino IDE. The main objective was to demonstrate
the feasibility and benefits of incorporating this technology
into the bone maceration process, achieving precise control
of critical variables such as temperature, agitation, and water
flow. The results show a significant reduction in maceration
time for the experimental group compared to the control
group (60 hours versus 730 hours, respectively), without the
presence of foul odors or damage to the bones. These findings
highlight the efficiency and potential application of this
system in anatomical and osteotechnical practices,
representing a significant advancement in the automation
and optimization of biological processes through the use of
emerging technologies.

Comparison of maceration time. In this study, a significant
reduction in the time required for bone maceration was
observed in the experimental group compared to the control
group. Specifically, the maceration time in the experimental
group was 60 hours, while in the control group it was 730
hours. This notable decrease in processing time has important
implications for efficiency and practicality in anatomical
laboratories. The reduction of maceration time to just 60
hours in the experimental group was achieved through the
implementation of an IoT-based automated maceration con-
trol system, which allowed precise control of critical varia-
bles such as temperature, agitation, and water flow. In
contrast, the control group, which did not utilize agitation
or proper temperature control, required significantly more
time to reach a comparable degree of maceration. The
implications of this reduction in time are multiple. First,
improving the efficiency of the maceration process allows
for a greater number of experiments in a shorter period,
optimizing the use of laboratory resources. Additionally, the
ability to obtain maceration results in just 60 hours facilitates
more flexible and rapid scheduling of laboratory activities,
enabling researchers to respond more quickly to experimental
needs and analysis demands. Furthermore, this reduction in
time minimizes exposure to potential contaminants and re-
duces the need for constant monitoring, freeing up technical
staff for other important activities in the laboratory. Simonsen
et al. (2011) and Savitri et al. (2023) state that the decrease
in maceration time also implies less generation of foul odors
and a reduction in the risks associated with the prolonged
handling of decomposing biological samples.

Effectiveness of controlling critical variables. The
effectiveness of controlling critical variables such as
temperature, agitation, and water flow in the bone maceration

process was evaluated in this study by comparing two expe-
rimental groups: one subjected to controlled conditions and
another under traditional conditions without precise control.
The results indicated that precise control of these variables
had a significant impact on the quality and consistency of
the macerated specimens. Temperature is a fundamental
variable in the maceration process, as it directly influences
the rate of soft tissue decomposition. In the experimental
group, the temperature was consistently maintained at 35°C
using a W1209 digital thermostat with a relay, whereas in
the control group it was kept at 10°C without additional
regulation. The specimens in the experimental group
achieved complete maceration in 60 hours, with bones clearly
visible and no demineralization, in contrast to the 730 hours
required in the control group, where maceration was
incomplete with a significant presence of adhered soft tissue.
Odukoya et al. (2017), reported similar results, comparing
the effectiveness of cold and hot water maceration techniques
for developing bone specimens from cadavers. Hot water
maceration showed changes in bone color and bones were
very soft after bleaching but hardened upon drying in the
sun. Cold water maceration, although slower, better
preserved bone integrity. Agitation, controlled at 1500 r/min
in the experimental group using a magnetic stirrer, also
proved to be significant in improving the maceration
process's efficiency. Constant agitation facilitated a
homogeneous temperature distribution and accelerated the
removal of soft tissue. In the absence of agitation, as in the
control group, the process was considerably slower and less
uniform, resulting in specimens with variations in the degree
of cleanliness and bone exposure. Water flow, maintained at
a rate of 900 ml/h in the experimental group, contributed to
the continuous renewal of the maceration medium, removing
decomposition products that could inhibit the process.
Continuous water renewal during maceration has been
described previously. For example, Dekeirsschieter etal.
(2009) stated that it not only improved process efficiency
but also significantly reduced the generation of foul odors,
a common issue in traditional maceration methods. In the
control group, the lack of water flow resulted in the
accumulation of waste and unpleasant odors, as well as a
less efficient maceration process.

Cost and accessibility of the device. The bone maceration
control system developed in this study, costing 60 USD,
stands out for its cost-effectiveness and accessibility.
Compared to commercial systems that cost hundreds or
thousands of dollars, it is an attractive option for laboratories
with limited budgets. Its low cost allows the implementation
of advanced technology without significant investment. The
system, which controls critical variables such as temperature,
agitation, and water flow using IoT with NodeMCU and
Arduino IDE, surpasses many traditional systems that rely
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on manual adjustments and constant supervision. By utilizing
open-source components like NodeMCU, the DS18B20
sensor, and the W1209 thermostat, the design is
straightforward and customizable, allowing laboratories of
various sizes to adopt the system without requiring advanced
technical skills or expensive equipment. NodeMCU, with
its Wi-Fi module and powerful processor, is an economical
and efficient alternative to other microcontrollers like
Arduino. For example, in IoT-based inventory management
systems, NodeMCU has proven to be convenient and cost-
effective, integrating with sensors and cloud storage without
the need for additional components (Mansor et al., 2023).
The combination of NodeMCU and Arduino IDE has enabled
the creation of reconfigurable testbeds for real-time IoT
applications, particularly useful in educational settings (Le-
Viet et al., 2019). In smart home applications, NodeMCU
reduces hardware costs by simplifying circuits, making
solutions more affordable and scalable (Qiang et al., 2018).
In educational environments, these devices enable low-cost
scientific experiments (Hyun et al., 2021). The use of
NodeMCU and LoRa technology in microclimate monitoring
demonstrates its effectiveness and low cost, ideal for remote
areas without constant internet access (Camparim et al.,
2022).

Performance of electronic components. The bone
maceration control system based on NodeMCU and
associated modules has been extensively evaluated,
highlighting both its strengths and areas for improvement.
The NodeMCU, with its ESP-12E chip, provided effective
WiFi connectivity and processing power, facilitating
programming through Arduino IDE and enabling reliable
real-time data transmission. However, using the ESP32 could
enhance future performance with greater power and
Bluetooth capability. Compared to other maceration
methods, such as those evaluated by Keyes et al. (2024), the
system with NodeMCU demonstrates advanced
technological integration. However, similar to the studies
by Steadman et al. (2006), the DS18B20 temperature sensor
was accurate, but the NTC sensors in the W1209 thermostat
exhibited durability issues due to water leakage. To address
this, it is recommended to improve the sealing or use higher
quality sensors. The DS3231 clock module functioned
correctly, maintaining reliable timekeeping even without
power, which is crucial for precise time tracking. Compared
to the work of King & Birch (2015), the integrity of the
neodymium magnet in the magnetic stirrer, which maintained
agitation at 1500 r/min, could be an area for improvement.
It is suggested to use professional laboratory stirrers or
centrifugal pumps for greater stability. The aquarium heater,
controlled by the W1209 thermostat, maintained the desired
35°C. However, as suggested by studies by Franchi et al.
(2011) and Frank et al. (2015), it is recommended to use

glass heaters for safety. These findings underscore the
effectiveness of the NodeMCU-based maceration system and
highlight the need for improvements to ensure its robustness
and performance in forensic and laboratory contexts.

Monitoring and remote control. Remote monitoring and
data storage via WiFi provided significant benefits in the
developed bone maceration system. The ability to monitor
critical variables in real-time, such as temperature, agitation,
and water flow, allowed precise and continuous control
without constant supervision, enhancing operational
efficiency and process consistency (Drakshayani et al.,
2022). Storing data on an SD card provided a detailed re-
cord for subsequent analysis, crucial for evaluating perfor-
mance and making adjustments to the experimental protocol,
thereby improving reproducibility. Remote access facilitated
the management of laboratory time and resources, enabling
researchers to review progress from any location
(Alsayaydeh et al., 2023). Future developments could
include a mobile application for remote control of system
variables, allowing real-time adjustments and programming
alarms and notifications for deviations, ensuring immediate
responses. Additionally, the application could offer an
intuitive interface to customize and save maceration profiles
for different samples, increasing the system's adaptability
(Ladino-Moreno et al., 2023). Integrating artificial
intelligence could automatically optimize conditions based
on historical and real-time data, reducing the need for ma-
nual intervention and enabling an almost autonomous
process.

Comparison with existing technologies. The IoT-based
bone maceration system is similar in many respects to
bioreactors used in microbiology, although each has specific
applications and key differences in their configurations and
objectives. Both systems aim to optimize biological
processes through precise control of critical variables and
automation, but significant opportunities exist to improve
the efficiency of the bone maceration system by
incorporating technologies and techniques commonly used
in bioreactors. Microbiology bioreactors are highly
sophisticated and designed to control and monitor a wide
range of parameters, including temperature, pH, dissolved
oxygen, and agitation speed, among others. These systems
often incorporate advanced sensors and feedback
technologies that allow real-time adjustments to optimize
microorganism growth and production (Zhang et al., 2010;
Rauh et al., 2011). Integrating advanced sensors and
actuators into the bone maceration system could significantly
improve its efficiency. Additional sensors to monitor waste
concentration and water quality would allow automatic
adjustments to maintain optimal conditions throughout the
process. Continuous filtration systems could also improve

RIVERA, J. & SALINAS, P. Low-cost and accessible scale body maceration control system: Integration of internet of things-NodeMCU with Arduino-IDE. Int. J. Morphol., 42(5):1239-1247, 2024.



1245

the quality and consistency of the macerate. In bioreactors,
filtration systems are used to remove waste products and
keep the medium in optimal conditions (Janssen et al., 2005).
Similarly, a filtration system in the bone maceration process
could remove debris and particles, reducing water turbidity
and improving the process's visibility and effectiveness. This
would not only keep the medium clean but also prevent the
accumulation of unpleasant odors, a common concern in
traditional maceration methods. Using high-pressure water
jets could be another significant advancement. Bioreactors
often use sophisticated agitation systems to ensure the
homogeneous mixing of nutrients and microorganisms. In
the context of bone maceration, high-pressure water jets
could provide more effective agitation, ensuring proper water
circulation around the specimens and improving theremoval
of soft tissue (Stevens et al., 2005). Integrating an advanced
interface for remote control and monitoring of the system
would also benefit from developments in bioreactor
technology. A mobile application or web-based interface
allowing users to adjust parameters and monitor the process
in real-time, along with receiving alerts and notifications
about the system's status, would increase the convenience
and effectiveness of the maceration system.

Impact on education and anatomical practices. The
implementation of IoT technologies in anatomical education
and specimen preparation has the potential to revolutionize
these fields, offering significant benefits in terms of
efficiency, precision, and accessibility. Modernizing and
digitizing traditional anatomical practices through IoT can
transform both teaching and research in anatomy. One of
the most notable impacts is the improvement in the quality
and consistency of prepared specimens. The ability to
precisely control critical variables such as temperature,
agitation, and water flow ensures that specimens are prepared
uniformly and reproducibly, significantly enhancing the
learning experience for students (Patra et al., 2022). Well-
prepared specimens allow for better visualization and
understanding of anatomical structures, facilitating more
effective teaching. The digitization of anatomical practices
through IoT technologies also allows for the automation of
processes that are traditionally labor-intensive and time-
consuming. The ability to remotely monitor and adjust
maceration conditions reduces the need for constant
supervision, freeing up time and resources for laboratory
staff. This automation increases operational efficiency and
enables researchers and educators to focus on more complex
and creative activities, such as designing new experiments
or improving teaching methods. Real-time data collection
and storage are other significant benefits of IoT technology
(Grignon & Duparc, 2021). The ability to continuously re-
cord process conditions and specimen status provides a
valuable database that can be used to analyze and optimize

preparation protocols. These data can be shared among
different educational and research institutions, promoting
collaboration and standardization of anatomical practices.
Furthermore, the integration of IoT technologies in specimen
preparation can enhance laboratory safety. The ability to
remotely monitor critical conditions and receive real-time
alerts allows for quick responses to any issues, minimizing
risks associated with handling biological materials and using
laboratory equipment (Lazarus et al., 2024). This is
especially relevant in educational settings, where student
safety is a priority. From an educational perspective, IoT
technology also offers opportunities for developing new
teaching tools. The possibility of creating mobile applications
or online platforms that provide real-time data access and
allow remote control of maceration processes can enrich the
learning experience (Bodur et al., 2019). Students could
interact with these tools to better understand the principles
behind specimen preparation and the importance of
controlled variables in biological experiments.

Improvements, future applications, and scalability. The
bone maceration control system has significant potential for
improvements and scalability. Using the ESP32 can enhance
processing capacity and add Bluetooth functionality.
Improving the sealing of the NTC sensors or replacing them
with higher-quality sensors would increase durability. The
magnetic stirrer could be replaced with a laboratory-grade
model or a centrifugal pump system for greater stability.
Glass heaters, instead of stainless-steel ones, would enhance
safety. The adaptable design allows its use in preparing small
samples and in larger volumes for industrial applications.
Scalability can be achieved by increasing the capacity of
the containers and adding additional components. Larger
capacity tanks with more powerful agitation and heating
systems would enable the processing of larger volumes.
Complete automation would be achieved by integrating
controlled inputs such as bacteria, gases, liquids, solids,
nutrients, detergents, and/or bleaches. Specialized bacteria
and nutrients would optimize maceration, while gases like
oxygen would accelerate decomposition (Molina et al.,
2019). Abrasive solids could remove resistant tissue
remnants. Precise sensors and actuators, connected to the
IoT system, would allow specific programming of agitation,
temperature, and water flow cycles, ensuring optimal
conditions and minimizing manual intervention. An
advanced interface, possibly via a mobile application, would
facilitate remote management. Artificial intelligence
functions could automatically optimize process conditions
based on historical and real-time data, maximizing the
efficiency and quality of maceration.

System limitations. During the implementation of the bone
maceration control system, several limitations were

RIVERA, J. & SALINAS, P. Low-cost and accessible scale body maceration control system: Integration of internet of things-NodeMCU with Arduino-IDE. Int. J. Morphol., 42(5):1239-1247, 2024.



1246

identified. The durability of the waterproof NTC
temperature sensor was a primary issue, as water penetrated
the epoxy resin seal, causing failures in temperature
readings and thermal control. We recommend using higher
quality sensors or improving the existing ones by
encapsulating them in stainless steel or installing them
through a waterproof connection in the container wall.
Another limitation was the stability of the magnetic stirrer.
The neodymium magnet tended to detach at high speeds,
compromising agitation. We suggest using laboratory-grade
magnetic stirrers or centrifugal pump systems to enhance
the consistency and efficiency of the process. Scalability
and adaptability were also limited, as the system was
optimized for small volumes. To improve scalability,
versions with larger capacity and additional components
such as cranes, filtration systems, wastewater treatment
mechanisms, and odor control mechanisms could be
developed. The user interface and remote-control
capabilities require improvements. Although the system
allowed for remote monitoring via WiFi and data storage
on an SD card, a mobile application could facilitate real-
time control with advanced features like alarms and
notifications.

CONCLUSIONS

Precise control of temperature, agitation, and water
flow allowed for high-quality, consistent macerated
specimens, optimizing processing time and reducing
complications associated with traditional methods. This
underscores the importance of automation and continuous
monitoring in anatomical techniques, presenting a
significant advancement in the preparation of specimens
for morphological and anatomical studies. The developed
cadaveric maceration control system is cost-effective and
expands technological possibilities in anatomical
laboratories, enhancing the accessibility and functionality
of traditional maceration methods. While the system has
proven effective and reliable, areas for improvement have
been identified that could increase its robustness and per-
formance. Implementing these enhancements would
optimize the system, making it more efficient and safer for
future applications. Remote monitoring and data storage
via WiFi improve operational efficiency, precision, and
flexibility. The incorporation of a mobile application for
remote control promises to enhance these capabilities,
offering more sophisticated and personalized control of the
maceration process and opening new possibilities for the
automation and optimization of anatomical techniques. This
innovative approach can transform the preparation of
anatomical specimens, making the process faster, cleaner,
and more reproducible. The modernization and
digitalization of traditional anatomical practices with IoT

can significantly improve specimen preparation and
anatomical education, benefiting students, researchers, and
educators. The scalable bone maceration system based on
the NodeMCU development board has improved the per-
formance and adaptability of existing systems, extending
its accessibility by reducing cost, complexity, and odors,
making it useful for forensic science, private conservation
workshops, and educational purposes.

RIVERA, J. & SALINAS, P. Sistema de control de maceración
corporal a escala accesible y de bajo costo: Integración de internet
de las cosas-NodeMCU con Arduino-IDE. Int. J. Morphol.,
42(5):1239-1247, 2024.

RESUMEN: El rápido avance del Internet de las Cosas
(IoT) ha transformado nuestras vidas al conectar objetos y crear
un entorno inteligente que impulsa la automatización y la recolec-
ción masiva de datos. El IoT ha superado desafíos a través del
monitoreo remoto, la robótica y los sensores, con tecnologías
inalámbricas potentes que abren posibilidades en diversos cam-
pos, incluidas la anatomía y las técnicas anatómicas. El objetivo
de este estudio fue demostrar la viabilidad y los beneficios de inte-
grar la tecnología IoT en el proceso de maceración cadavérica
mediante el desarrollo de un dispositivo de control de maceración
automatizado, accesible y de bajo costo, compatible con el entor-
no de programación Arduino IDE. Usando un sistema NodeMCU
de código abierto basado en el chip ESP-12E, que emplea el len-
guaje de programación LUA y es compatible con Arduino IDE,
incorporamos un módulo lector de tarjetas microSD para el alma-
cenamiento de datos, un sensor de temperatura digital (DS18B20),
un módulo de reloj (DS3231), un agitador magnético y un calenta-
dor de acuario controlado por un termostato digital con relé
(W1209). Para validar el dispositivo, realizamos pruebas de
maceración en ratones C57BL, comparando dos grupos: control
(n=5; peso=17g) sometido a maceración en 4 litros de agua a 10°C
sin agitación; experimental (n=5; peso=17g) expuesto a maceración
en 4 litros de agua a 35°C, con agitación a 1500 r/min y renova-
ción del flujo de agua a una velocidad de 900 ml/h. Los especímenes
fueron evaluados según su grado de maceración, limpiados, pesa-
dos y fotografiados. El tiempo de maceración para los grupos con-
trol y experimental fue de 730 horas y 60 horas, respectivamente.
En el grupo experimental no se detectaron malos olores, daños ni
desmineralización de los huesos. El costo del dispositivo fue de 60
USD y la programación a través del entorno Arduino IDE fue sen-
cilla. El enfoque en el hardware contribuyó a la accesibilidad y al
ahorro de tiempo. El sistema operaba con una fuente de alimenta-
ción convencional y requería un suministro de agua, lo que lo hace
adaptable a diversas configuraciones con mayor capacidad. Bajo
esta configuración, controlamos eficazmente las variables (tempe-
ratura, agitación y flujo de agua). El sistema de maceración ósea
basado en NodeMCU mejoró el rendimiento y la adaptabilidad de
los sistemas existentes, y aumentó la accesibilidad al reducir los
costos, la complejidad y los malos olores.

PALABRAS CLAVE: Anatomía; Internet de las Co-
sas; Técnica Anatómica; Maceración; Arduino;
Automatización.
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